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1 About SDN

The salient features of SDN are:

e Directly programmable: SDN decouples the network control and forwarding functions. SDN allows
programming the network control plane by abstracting the physical infrastructure.

e Agile: Decoupling and abstracting network control from forwarding helps administrators dynamically
adjust network-wide traffic flow to meet the changing needs in the networks.

e Centrally managed: Network intelligence is centralized (logically) in software based SDN controllers
that maintain a global view of the network, which appear to applications and policy engines as a
single, logical switch.

e Programmatically configured: SDN lets network managers configure, manage, secure, and optimize
network resources very quickly via dynamic, automated SDN programs, which they can write easily
and quickly, because the programs do not depend on proprietary software.

e Open standards-based and vendor-neutral: Because SDN is implemented through open standards,
SDN simplifies network design and operation because instructions are provided by SDN controllers
instead of multiple, vendor-specific devices and protocols.

2 SDN in NetSim

SDN is available in NetSim from version 11 onwards. NetSim ‘simulates’ OpenFlow protocol. OpenFlow
is an open interface to remotely control the forwarding tables in network switches, routers, etc.

2.1 SDN Controller in NetSim

An SDN controller is an application in SDN that manages flow control to enable intelligent networking.
SDN controller can be used to control the packet forwarding of all Layer 3 devices in the network.

SDN controller lies between the network devices and the applications. Any communication between
applications and devices must go through the controller.

NetSim has inbuilt controllers that ‘simulate’ SDN. An SDN controller in NetSim contains a Command
Line Interface (CLI) to allow you to configure properties, such as, the IP forwarding table for different
devices in the network.

NetSim also provides a platform whereby users can develop various kind of commands/interface com-
patible to any SDN enabled device.

In NetSim, any Layer 3 device can be configured as an SDN Controller. Multiple controllers can be
configured in a network scenario. The following is a list of Layer 3 devices you can configure as an SDN
controller:

e Internetworks — Nodes (Wired, Wireless Node), Routers

¢ MANETS — Nodes (Wired, Wireless Node), Bridge Node (Wired, Wireless Node), Routers
e WSN - Sensors and Sink Node

e IOT - Sensors and Gateway (LowPAN Gateway), Nodes (Wired, Wireless Node), Routers
e Cognitive Radio — CR CPE, Nodes (Wired, Wireless Node), Routers

e LTE - UE, EPC, Nodes (Wired, Wireless Node), Routers

e VANETS — Vehicle and RSU

¢ 5G mmWave — UE, Nodes (Wired, Wireless Node), Routers

NOTE: NetSim ‘simulates’ SDN protocol and cannot connect to real controllers such as Open Daylight.
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2.2 CLI Commands for SDN in NetSim
You can use the following commands when you simulate SDN in NetSim:

e Simulation-specific — Pause, PauseAt, Continue, Stop, Exit, and Reconnect.
e Route — route add, route print, and route delete.
e Ping Command — ping (not supported on some network types, for example, Wireless Sensor Network)

e ACL configuration — ACL Enable, ACL Disable, ACL Print, and aclconfig.

Notes: CLI commands in NetSim are NOT case-sensitive. To get detailed help about how to use CLI
commands in NetSim, see Section 3.14 NetSim Interactive Simulation in User Manual.

2.3 Configuring SDN in NetSim

SDN protocol parameters can be accessed and configured from the Application layer properties of the
devices.

e Open-flow protocol must be enabled in the devices which are configured as SDN Controller or SDN
clients.

e SDN Controller device must have the SDN Controller option set to True.

e SDN Client devices must have the SDN Controller option set to False along with the Controller Device
Name set as the SDN Controller Device Name.

e Interactive Simulation option needs to be set to True in the Run time interaction tab.

When SDN commands are executed during runtime either via console or via file input, commands and
response are exchanged between the controller and clients using TCP.

2.4 How to use CLI Commands for SDN

Each device in NetSim has a console which can be accessed by right clicking on the device. Users can
execute supported SDN commands on the console of the SDN controller node to configure other nodes
in the network. Let us look at a few examples.

Example 1: To view the IP routing table of a node that is controlled by the SDN controller, use the
following command syntax: <DeviceName with Device ID> route print.

e For example, type Wired Node 2 route print and press Enter.

The following image illustrates the output for the command.

® C\Program Files\NetSim'\Pro_v14_2\bin\NetSimCLl.exe - [m] X

Figure 2-1: Printing IP routing table in Console
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Example 2: To initiate ping from one node to another node where both nodes are controlled by the
SDN controller, following command can be executed in the SDN controller:

<DeviceName with Device ID> Ping <DeviceName with Device ID> or <DeviceName with Device
ID> Ping <IP Address>.

e For example, type Router 3 ping Router 4 or Router 4 ping 11.0.0.2 and press Enter.

B C\Program Files\NetSim\Pro_v14_2\bin\NetSimCLl.exe - [m] X

Figure 2-2: Pinging Router 4

NOTE: In order to initiate ping between the devices, ICMP protocol which is present in the Network
Layer properties of the devices must be set to TRUE.

2.5 Excluded Features

Multiple controllers can be configured in NetSim. However, intercontroller communication requires the
user to write their own code in NetSim.

2.6 Troubleshooting issues in executing SDN commands
When executing SDN commands in the SDN controller, there can be cases where there is no response
coming back. Some of the reasons for this are listed below:

SDN Controller and SDN client are unable to communicate (not reachable).

e Part of two different networks

e Due to the distance between the devices in the case of wireless nodes
Failed TCP connection attempts due to high error or collision

e Commands for Controller to the client and response from the client to the controller are passed as
TCP packets.

e The TCP connection attempt fails if the maximum connection attempt is reached.

High network traffic due to application packets exchanged during the simulation

Some suggestions to resolve issues with SDN command execution are listed below:

e Connectivity between the SDN controller and clients should be ensured.

e Application start time can be increased to allow necessary SDN commands to be executed prior to
application traffic flow which will also avoid contention especially in the case of Wireless devices.
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e SDN commands can be passed as input via file-based interactive simulation for higher accuracy in

terms of the time at which the commands are to be executed.

3 Featured Examples

NetSim provides inbuilt examples to get started with the SDN module. To access these examples, you
can go to Examples ; Software-Defined-Networks in the NetSim Home Screen. You can change the
default values of the parameters in these examples and see how they affect the performance of the SDN

network.

3.1 Configuring SDN

3.1.1 Configuring One SDN Controller in a Simple Internetwork

The Internetwork model in this example consists of the following configuration:

NS o e e

To simulate the example for One SDN controller in an Internetwork:

Simulation time is set to 500 seconds.

Packet trace is enabled.

Only one router is configured as the SDN controller.

Open Flow protocol is enabled on all wired nodes and routers.

A unicast application is set between Wired Node 1 to Wired Node 2.
Set Transport Protocol to TCP in Application Properties.

A subnet with 2 wired nodes, 3 routers, and a unicast application running on one of the wired nodes.

Open NetSim and Select Examples ; Software Defined Networks j Configuring SDN ; SDN Internetworks
then click on the tile in the middle panel to load the example as shown in below

[ NetSim Home
NetSim Professional

Network Simulation/Emulation Platform
Version 14,28 (64 Bit)

New Simulation

Your Work
Bxamples

Experiments

License Settings

Support

CuleN  Example Simulations

Cirl-0

AeFd

Internetworks

Advanced Routing

Mobile Adhoc Networks
Software Defined Networks

4 Configuring SN
SDN Internetworks

WSN Setting Multiple SDN Controllers

MANET StaticRoute
Internetworks StaticRoute
WSN StaticRoute

1oT-W
Cognitive Radio Networks
LTE and LTE-A

VANETs ©

Satellite Communication
5GNR

TDMA Radio Networks
Underwater Acoustic Networ

SDN Internetworks

A simple example with involving one SDN controller. This exsmple ic developed in the

intemetworks library

SON Intermetwrarks

Enabled open flow in ll devices
Changed SDN controller device name
Transpart protecol: TCP

Documentation

Results

Contact Us
Email - sales@tetcos.com
Phone - +01 767 605 4321
Website

Figure 3-1: List of scenarios for the example of SDN Internetworks

wse s

N Contrter

FaLSE SO Coriroler

Ready 1o simulate scenarios to understand the working of the different technology ibraries in NetSim. Expand and click on the file name to display simulation examples. Then click on 2 tile in the middie pane! to load the
simulation. Click on the book icon on the leit (Example Simulations) panel to view documentation (pdf)

1. The following network diagram illustrates what the NetSim UI displays when you open the example
configuration file for SDN as shown Figure 3-2.
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| .
App1_CBR

Wired_Node_1 Wired_Node_2
Figure 3-2: Network set up for studying the SDN Internetworks

2. In the application layer of the SDN Controller node:

a. SDN Controller option set to TRUE.
b. Open Flow protocol is enabled.

The following image illustrates the settings done in the SDN controller device:

EE SDN_Controller Properties — .

AN O -

r
1

LD

> General
> Position

4 Application Layer

4 Open Flow

Open Flow Enable TRUE v
SDN Controller TRUE A
> QSPF

Transport Layer
Network Layer
Interface_1 (WAN)
Interface_2 (WAN)

vV vV Vv V¥V

Figure 3-3: Application Layer properties Window of SDN_Controller device

3. In the other devices (Routers and wired node) that are part of the network,

a. SDN Controller option is set to FALSE.

Ver 15.0

b. SDN Controller DeviceName is set as “SDN Controller” which is the name of the controller

node.

c. Open Flow protocol is enabled.

The following image illustrates settings done in the other devices:
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H Wired_Node_1 Properties — X

SANO W

> General
> Position

4 Application Layer

4 Open Flow

Open Flow Enable TRUE -
SDN Contraoller FALSE v
SDN Contraller Device Name SDN_Controller

&> Transport Layer
&> Network Layer

&> Interface_1 (Ethernet)

Figure 3-4: SDN Controller DeviceName is set as SDN Controller in Application layer

The following table lists the settings done in all the devices that are part of the network:

Table 3-1: Set the properties for all the devices

Device Name Open Flow SDN Controller SDN Controller DeviceName

Wired Node 1 Enable FALSE SDN Controller
Router 3 Enable FALSE SDN Controller
SDN Controller Enable TRUE NA

Router 5 Enable FALSE SDN Controller
Wired Node 2 Enable FALSE SDN Controller

4. Configure an application between any two nodes in the scenario by selecting an application from the
Set Traffic tab.

a. CBR Application from Wired Node 1 to Wired Node 2 with 50 Mbps Generation Rate (Packet
Size: 1460Bytes, Inter Arrival Time: 233.6us).

b. Set Transport Protocol to TCP.

5. Before simulating the example, Right-click SDN Controller and select NetSim Console. Now, the
client (NetSimCLI.exe) waits to establish a connection with NetSimCore.exe as shown below.

B C\Program Files\NetSim Pro\bin\MetSimCLI.exe

NetSim:>

Figure 3-5: Connection Establishment

6. Follow the below steps to simulate an example.
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a. Click on the Options tab. Select Run time interaction.

& File  Options  Help | Network: Internetworks | Workspace: 30ct2023

JE Create| Open MATLAB Interface 21l Configure Reports 35! Show/Hide Info

= ®

Run Time Interaction
g i
@ Save oo Wired Node =] L2 switch

(—D Close &/ g Wireless Node @ L3 Switch

File Run Simulation Node Switch

Figure 3-6: Run Time Interaction option in NetSim GUI

Access Point Router Wired/Wireless Links

Ver 15.0

b. In the Run Time Interaction tab, set Interactive Simulation to True and click on OK.

¥ Runtime Interaction ]

NetSim allows users to interact with simulations at runtime via command execution to
view/modify certain device parameters during runtime.

There are two options available for runtime interaction. Interaction can be set to be via a
socket or through a 'input.txt’ file in a predefined format.

This input.txt file accepts all the commands that NetSim's interactive simulation supports.

Interactive Simulation True M

File Name Input File Browse

OK Cancel

Figure 3-7: Enable Interactive Simulation

c. Click on Run Simulation window and simulate it to 500 secs.

gi NetSim - Run Simulation

Simulation Time

Enter desired simulation time. Valid range is 0.0001 to 100,000 seconds.

Simulation Time | 50¢|

Seed Value
Enter seed value between 1 to 99,999,999. The seed values are used to generate random

numbers in simulation.

Seed 1 12345678 Seed 2 23456789

Run Cancel

Figure 3-8: Run Simulation Window

Simulation (NetSimCore.exe) starts to run. NetSimCore.exe displays the following message: waiting for

the first client to connect.

Copyright TETCOS LLP
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1 C:\Users\JAYDEN\Documents\NetSim\Workspaces\gribin_x64\NetSimCore.exe - o X

y. Error number 17

Figure 3-9: Waiting for first client to connect.

d. Use this console to execute SDN commands as explained in section 2.2.

3.1.2 Configuring Multiple SDN Controllers in a Wireless Sensor Network

In this example, multiple SDN controllers are configured in a Wireless Sensor Network.

The Wireless Sensor Network model in this example consists of the following configuration:

e A subnet with 4 wireless sensors, 1 ad-hoc link, 1 WSN sink node, and a unicast sensor application
running on one of the wireless sensors.

e Set Transport Protocol to TCP in Application Properties.

Two wireless sensors are configured as SDN controllers.

Open Flow protocol is enabled on all wireless sensors and sink node.
NetSim uses the following defaults for this SDN example:

a. The unicast application transmits data from Wireless Sensor 3 to Wireless Sensor 5.
b. Simulation runs for 500 seconds.

c. Packet trace is enabled.

NOTE: For a WSN network, ping command is not supported on ZigBee device since these nodes do not
support ICMP protocol.

To simulate the example for multiple SDN controllers in WSN for SDN:

Open NetSim and Select Examples ; Software Defined Networks ; Configuring SDN ; WSN Setting
Multiple SDN Controllers then click on the tile in the middle panel to load the example as shown in
below screenshot
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[ etsim Home

NetSim Professional
Network Simulation/Emulation Platform
Version 14.2.8 (64 Bit)

New Simulation Ciri<N  Example Simulations

Your Work -0 Internetworks
Advanced Routing 1
Mobile Adhac Networks

Software Defined Networks.

Examples

Experiments .
4 Configuring SDN
SDN Internetworks
MANET StaticRoute
Internetworks StaticRoute
'WSN StaticRoute
IOT-WSN i
Cognitive Radic Netwarks
LTE and LTE-A
VANETs ©
Satellite Communication 1.
3G NR
TDMA Radio Networks .
Underwater Acoustic Network
License Settings.

Exit AiteFa

WSN Setting Multiple SDN Controllers

Simulating multiple SDN controllers. This example is devioped for Wireless Sensor Networks

WSN Setting Multiple SON Controllers

Enabled open flow in all devices
Changed SDN controller device name
Network layer protocok: DSR
Interactive simulation: TRUE

Ver 15.0

Resuts

st
HE

e

[T re——— "
Whedes o 3 Eme PMSE 800 Contoler Semert

Rezdy to simulate scenarios to understand the working of the different technology libraries in NetSim. Expand and click on the file name to display simulation examples. Then click on a il in the middle panel to load the
simulation. Click on the book icon on the left (Example Simulations) panel to view documentation (pdf).

Support Learn

Documentation

Contact Us
Email - sales@tetcos.com
Phone - +91767 605 4321
Website : w tetcos.cor

Figure 3-10: List of scenarios for the example of WSN Setting Multiple SDN Controllers

1. The following network diagram illustrates the network setup related to this example as shown below.

EnPE

SDN_Controller_Sens
ort

couma e Shal
27 N 1T --l
-7 | S -l em ¢
. | J
- 1 S
i N
) T SDN_Controller_Sens
o ! T or2
[°] N
= L
— .
SDN_Controller_Sink )
Nede S
N

‘Wireless_Sensor_3

>
‘App1_SENSOR_APP

Wireless_Sensor_5

Figure 3-11: Network set up for studying the WSN Setting Multiple SDN Controllers

2. The SDN Controller Sensors, Wireless Sensors and the sinknode are configured as SDN controllers
with Open Flow protocol enabled in all the nodes.

The following image illustrates the settings done in the sensors configured as SDN controller as shown

below.
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EE SDN_Controller_SinkNode Properties

AN O =%

> General
> Position

4 Application Layer
4 Open Flow

Open Flow Enable
SDN Contraoller

> Transport Layer
> Network Layer
B> Interface_1 (Zigbee)

hl

Ver 15.0

e
o

-

-

Figure 3-12: Application Layer properties Window

3. The sensor SDN Controller Sensor 1 is set as the SDN controller for Wireless Sensor 3 and SDN
Controller Sensor 2 is set as the SDN controller for Wireless Sensor 5.

The following image illustrates the settings done in sensor 3.

N

" AN O

B General
B Position

4 Application Layer

4 Open Flow

Open Flow Enable

SDN Controller

= Transport Layer
B Metwork Layer
B Interface_1 (Zigbes)

0% @Y
=y Eg

-

-

Figure 3-13: SDN Controller DeviceName is set as SDN Controller in Application layer

The following table lists the default setting for the wireless sensors.

Table 3-2: Set the properties for all the devices

Device Name

Open Flow SDN Controller

SDN Controller DeviceName

SDN Controller Sink Node
SDN Controller Sensorl
SDN Controller Sensor2

Wireless Sensor3
Wireless Sensorb

Enable
Enable
Enable
Enable
Enable

TRUE
TRUE
TRUE
FALSE
FALSE

NA
NA
NA
SDN Controller Sensorl
SDN Controller Sensor2
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4. Configure an application between any two nodes in the scenario by selecting an application from the
Set Traffic tab.

a. Sensor Application from Wireless Sensor 3 to Wireless Sensor 5 with Packet Size: 50Bytes, Inter
Arrival Time: 1000000us).

b. Set Transport Protocol to TCP.

5. Packet trace is enabled under configure reports tab.
6. To use the SDN CLI Console:
a. Right-click SDN Controller Sensorl or SDN Controller Sensor2 and click NetSim Console. Now,

the client (NetSimCLI.exe) starts and tries to establish a connection with NetSimCore.exe.

The following image illustrates the NetSim CLI console.

B C\Program Files\MNetSim\Pro_v14_2\bin\MetSimCLl.exe

Figure 3-14: Connection established.

7. Simulate the example. To do so:

a. Click on the Options tab. Select Run time interaction.

ﬁ File Options Help | Network: Internetworks | Workspace: 30ct2023

J£ Create| Open MATLAB Interface 11l Configure Reports 25 Show/Hide Info
Run Time Interaction —
. N .
B Save Static ARP Wired Node «3| L2 Switch @ a\
N i % H R
<—D Close L1 Wireless Node \i‘/ L3 Switch
File Run Simulation Node Switch Access Point Router ‘Wired/Wireless Links

Figure 3-15: Run Time Interaction in NetSim GUI

b. In the Run time Interaction tab, Interactive Simulation option is set to True and click on OK.

E Runtime Interaction — O X

NetSim allows users to interact with simulations at runtime via command execution to
view/modify certain device parameters during runtime.

There are two options available for runtime interaction. Interaction can be set to be viaa
socket or through a ‘'input.txt’ file in a predefined format.

This input.txt file accepts all the commands that NetSim's interactive simulation supports.

Interactive Simulation True v

File Name Input File Browse

OK Cancel

Figure 3-16: Runtime Interaction window

c. Click on the Run Simulation window and simulate it to 500 sec.
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% NetSim - Run Simulation — X

Simulation Time

Enter desired simulation time. Valid range is 0.0001 to 100,000 seconds.

Simulation Time | 500|

Seed Value
Enter seed value between 1 to 99,999,999. The seed values are used to generate random

numbers in simulation

Seed 1 12345678 Seed 2 | 23456789

Run Cancel

Figure 3-17: Run Simulation Window

e upto 2 min) -

Error number 17

Figure 3-18: Waiting for first Client to Connect
You can execute various SDN commands that are supported in any of the SDN controller Sensor CLI.

3.2 Configuring Static Routes for a MANET Network by using SDN

In this example static routes are configured using the SDN controllers, in a MANET network.

The MANET network model in this example consists of the following configuration:

e A subnet with 5 wireless nodes and 1 ad-hoc link, and a unicast CBR application running on one of
the wireless nodes.

e DSR is the routing protocol that is enabled on all wireless nodes.

e One wireless node is configured as the SDN controller.

e Wireless nodes do not have mobility.

e A unicast application is configured from Wireless Node 1 to Wireless Node 5.
e Simulation time is set to 500 seconds.

e Packet trace is enabled.

To simulate the example for MANET using SDN:

Open NetSim and Select Examples ; Software Defined Networks ; MANET StaticRoute then click on
the tile in the middle panel to load the example as shown in below screenshot
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[ MetSim Home

NetSim Professional
Network Simulation/Emulation Platform
Version 14.2.8 {64 Bit)

New Simulation Ctd+N Example Simulations
Your Work Cul-0 Intemetworks
Eamples Aduanced Routing

Mobile Adhoc Networks

Experiments. ‘

metworks StaticRoute
WSN StaticRoute

I0T-WSN

Cognitive Radio Networks
LTE and LTE-A

VANETs ©

Satellite Communication

5G NR

TDMA Radio Networks
Underwater Acoustic Network

Bt AtFe

Ready to simulate scenarios to Understand the working of the different technalogy libraries in NetSim. Expand and click on the file name to display simulation examples. Then click on a tile in the middle panel to load the
simulation. Click on the book icon on the let (Example Simulations) panel to view decumentation (pdf).

Support Leamn

Figure 3-19: List of scenarios for the example of MANET StaticRoute

The following network diagram illustrates the network setup.

MANET StaticRoute

In this example, static routes are

MANET StaticRoute

Enabled open flow in all devices

Network layer pratocak DSR
Interactive simulation: TRUE

Changed SON controller device name

Wireless_Node_3
i

configured using the SDN controllers, in a MANET network.

Website

Wireless_Node_1

Figure 3-20: Network set up for studying the MANET Static Route

>
App1_CBR

Wireless_Node_5

Ver

15.0

. DSR routing protocol is configured in Network layer for all the nodes and set the nodes to be stationary.

1
2. Mobility model is set to NO MOBILITY in all the nodes.

3. ICMP protocol is enabled in the network layer properties of all the wireless nodes.
4

Open flow protocol is enabled in all the wireless nodes.

The following settings were done in the wireless nodes to configure Wireless Node 4 as SDN controller

and other nodes as its clients.

Table 3-3: Set the properties for all the devices

Device Name

Open Flow SDN Controller

SDN Controller DeviceName

Wireless Node 1  Enable
Wireless Node 2 Enable
Wireless Node 3 Enable
SDN Controller  Enable
Wireless Node 5 Enable

FALSE
FALSE
FALSE
TRUE

FALSE

SDN Controller
SDN Controller
SDN Controller
N/A

SDN Controller

5. Configure an application between any two nodes in the scenario by selecting an application from the

Set Traffic tab.
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a. CBR Application from Wireless Node 1 to Wireless Node 5 with 0.584 Mbps Generation Rate

(Packet Size:

1460Bytes, Inter Arrival Time: 20000us).

b. Set Transport Protocol to UDP.

6. Click on link, expand the right-side property panel and set Channel Characteristics: Path Loss Only,
Path Loss Model: Log Distance, Path Loss Exponent: 2.5.

7. In NetSim Packet Trace is enabled under configure reports tab.

8. To use the SDN CLI Console:

a. Right-click SDN Controller and select NetSim Console. Now, the client (NetSimCLIL.exe) starts
and attempts to establish a connection with NetSimCore.exe.

B C\Program Files\MNetSim\Pro_v14_2\bin\MetSimCLIl.exe

Figure 3-21: Connection established.

9. Simulate the example. To do so:

a. Click on the Options tab. Select Run time interaction.

ﬁ File Options Help | Network: Internetworks | Workspace: 30ct2023

2 Create| Open MATLAB Interface 11l Configure Reports % Show/Hide Info
-

E Save Static ARP Wired Node =3 Switch @
v 5 ) Hoooeo(
(—D Close & E Wireless Node \ﬁ L3 Switch -

File

Run Simulation Node Switch Access Point Router Wired/Wireless Links

Figure 3-22: Runtime Interaction in GUI

o

b. In the Run time Interaction tab, Interactive Simulation option is set to True and click on OK.

m Runtime Interaction - u x

NetSim allows users to interact with simulations at runtime via command execution to
view/modify certain device parameters during runtime.

There are two options available for runtime interaction. Interaction can be set to be via a
socket or through a ‘input.txt’ file in a predefined format.

This input.txt file accepts all the commands that NetSim's interactive simulation supports.

Interactive Simulation True v

File Name Input File Browse

OK Cancel

Figure 3-23: Enabling Run Time Interaction option.

c. Click on Run simulation window and simulate it to 500 sec.

Copyright TETCOS LLP
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% NetSim - Run Simulation — X

Simulation Time

Enter desired simulation time. Valid range is 0.0001 to 100,000 seconds.

Simulation Time | 500|

Seed Value
Enter seed value between 1 to 99,999,999. The seed values are used to generate random

numbers in simulation

Seed 1 12345678 Seed 2 | 23456789

Run Cancel

Figure 3-24: Run Simulation window

Simulation (NetSimCore.exe) starts to run. NetSimCore.exe displays the following message: waiting for
the first client to connect.

Error number 17

Figure 3-25: Waiting for the first Client to connect.
10. Interpret the Results

In the simulation results window select the Traces option in the left area and open the packet trace file.

Once the packet trace opens apply filter in the CONTROL PACKET TYPE/APP NAME for APP1
CBR.

a. The packets reach Wireless Node 5 from Wireless Node 1-; Wireless Node 3-;, Wireless Node 5.

PACKET_ID|-¥|SEGMENT_ID| - | PACKET_TYPE| - | CONTROL_PACKET_TYPE/APP_NAME -¥|SOURCE_ID| - | DESTINATION_ID| - | TRANSMITTER_ID| - | RECEIVER_ID| -
1 0 CBR App1_CBR NODE-1 NODE-5 NODE-1 NODE-3
1 0 CBR Appl CBR NODE-1 NODE-5 NODE-3 NODE-5

Figure 3-26: Packet trace screenshot

11. For the same example, configure static routes such that the packets will go through Wireless Node
1 j Wireless Node 2, Wireless Node 3, SDN Controller to Wireless Node 5. To configure the static
routes on SDN Controller for all the nodes.

Right-click SDN Controller and select NetSim Console.

Re-run the simulation.

c. Type the following commands on the NetSim CLI console, in the <DeviceName with Device
ID> route add <destination IP address> MASK <subnet mask> <gateway IP address> <metric>
if <interface #> format.
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. Wireless_Node_1 route ADD 192.168.0.6 MASK 255.255.255.0 192.168.0.3 METRIC 1 IF
1

Wireless_Node_2 route ADD 192.168.0.6 MASK 255.255.255.0 192.168.0.4 METRIC 1 IF
1

Wireless_Node_3 route ADD 192.168.0.6 MASK 255.255.255.0 192.168.0.5 METRIC 1 IF
1

SDN_Controller route ADD 192.168.0.6 MASK 255.255.255.0 192.168.0.6 METRIC 1 IF 1

87 CA\Program Files\NetSim\Pro_v14_2\bin\NetSimCLl.exe - u] X

METRIC 1 IF 1

METRIC 1 IF 1

5 METRIC 1 IF 1

Figure 3-27: NetSim Console Window

12. Interpret the Results.

a

. Open Packet trace and filter CONTROL PACKET TYPE/APP NAME to APP1 CBR, you
will see that data packets transmitted from Wireless Node 1 ; Wireless Node 2 ; Wireless Node
3 ; SDN Controller to Wireless Node 5 as part of the commands executed for static route
configuration.

PACKET_ID |+ |SEGMENT_ID |~ | PACKET_TYPE |.¥| CONTROL PACKET TYPE/APP NAME + | SOURCE ID |~ | DESTINATION ID |+ | TRANSMITTER |ID |~ |RECEIVERID |~
2185 0 CBR Appl CBR NODE-1 NODE-5 NODE-1 NODE-2
2185 0 CBR Appl_CBR NODE-1 NODE-5 NODE-2 NODE-3
2185 0 CBR Appl_CBR NODE-1 NODE-5 NODE-3 NODE-4
2185 0 CBR App1_CBR NODE-1 NODE-5 NODE-4 NODE-5
2186 0 CBR Appl_CBR NODE-1 NODES NODE-T NODE-2
2186 0 CBR Appl CBR NODE-1 NODE-5 NODE-2 NODE-3
2186 0 CBR Appl_CBR NODE-1 NODE-5 NODE-3 NODE-4
2186 0 CBR Appl_CBR NODE-1 NODE-5 NODE-4 NODE-5
2187 0 CBR App1_CBR NODE-1 NODE-5 NODE-1 NODE-2
2187 0 CBR App1_CBR NODE-1 NODE-5 NODE-2 NODE-3
2187 0 CBR Appl CBR NODE-1 NODE-5 NODE-3 NODE-4
2187 0 CBR Appl_CBR NODE-1 NODE-5 NODE-4 NODE-5
2188 0 CBR Appl_CBR NODE-1 NODE-5 NODE-1 NODE-2
2188 0 CBR App1_CBR NODE-1 NODE-5 NODE-2 NODE-3
2188 0 CBR Appl_CBR NODE-1 NODE-5 NODE-3 NODE-4
2188 0 CBR Appl CBR NODE-1 NODE-5 NODE-4 NODE-5
2189 0 CBR Appl_CBR NODE-1 NODE-5 NODE-1 NODE-2
2189 0 CBR Appl1_CBR NODE-1 NODE-5 NODE-2 NODE-3
2189 0 CBR App1_CBR NODE-1 NODE-5 NODE-3 NODE-4
2189 0 CBR App1_CBR NODE-1 NODE-5 NODE-4 NODE-5
2190 0 CBR Appl CBR NODE-1 NODE-5 NODE-1 NODE-2
2190 0 CBR Appl_CBR NODE-1 NODE-5 NODE-2 NODE-3
2190 0 CBR Appl_CBR NODE-1 NODE-5 NODE-3 NODE-4
2190 0 CBR App1_CBR NODE-1 NODE-5 NODE-4 NODE-5

Figure 3-28: Packet Trace Window

3.3 Configuring Static Routes for Internetworks using SDN
In the example the IP tables in the nodes and routers on an SDN network are modified using SDN CLI
commands.

The network model in this example consists of the following configuration:

Copyright TETCOS LLP Page 19 of 27



NetSim — Software Defined Networks Ver 15.0

A subnet with 2 wired nodes, 5 routers, and a unicast application running on one of the wired nodes.
e SDN controller running on one of the router.

e Set Transport Protocol to TCP in Application. Open Flow protocol is enabled on all wired nodes and
routers.

e A unicast application set from Wired Node 1 to Wired Node 2.

e OSPF is the routing protocol in the routers.

e The node SDN Controller is configured to be the SDN controller.
e Simulation time is set to 500 seconds.

e Packet trace, and Event trace are enabled.

To simulate SDN and change the IP tables:

Open NetSim and Select Examples ; Software Defined Networks ; Internetworks StaticRoute then click
on the tile in the middle panel to load the example as shown in below screenshot.

NetSim Home - o x

NetSim Professional
Network Simulatio/Emulation Platiorm
Version 1428 (64 Bit)

New Simulation CleN  Example Simulations Internetworks StaticRoute Results
Your Work =@ 1 Intemetworks In the example, the IP tables in the nodes and routers on an SDN network are modified using
; SON €U commands.
| xamples I 1 Advanced Routing
I Mobile Adhoc Networks » —
Experiments 4 Software Defined Networks
Canfiguring SON rebled apen 14
nabled open flow in all devices

MANET SiaticRaue Changed SDN cantroller device name

roapon eses

WSN StaticRoute Static route configuration via CLI
b0 IOT.WSN o * -
I Cognitive Radio Metworks T
b7 TEand ITE-A
I VANETS
I Satelite Communication
L0 SGNR
I TDMA Radio Networks
T Undenwater Acoustic Network

Type b ikowing cormanc cn the NetSn CLI coracl, 1t <Dewicshme a2h
License Settings o
ackiesss <mobics i cintctace £ o Router3 route ADD 18216802 WASK:
exit Atebd 5652662650 11002 METRIC 1 -2
Ready to simulate scenarios to understand the warking of the different technology braries in NetSim. Expand and cick on the fiie name to display simulation examples. Then dlick an & tile in the middle penel 1o load the
simulation, Click an the boak icon on the left (Example Simul panel o i (pei.
Support Leam Documentation Contact Us

Email - sales@tetcos.com
chnology Libraries Phane - <81 767 605 4321
e Code Hel Website <

Figure 3-29: List of scenarios for the example of Internetworks StaticRoute

The following network diagram illustrates the network setup related to this example.

4 ~, 5
~ A ‘/\ ,\\
> B R
Router 4 Router_ 5
2
3 e L6
Ny et 7
3 a B
Router3 SON_Controller Router d

oP1 CER

vired_Node_t Wired_Wode_2

Figure 3-30: Network set up for studying the Internetworks Static Route

1. Configure an application between any two nodes in the scenario by selecting an application from the
Set Traffic tab.
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a. CBR Application from Wired Node 1 to Wired Node 2 with 50 Mbps Generation Rate (Packet
Size: 1460Bytes, Inter Arrival Time: 233.6us).

b. Application Start time is 30 sec.
c. Set Transport Protocol to TCP.
2. Packet Trace and Event Trace features are enabled from Configure Reports.

3. To use the SDN CLI: Right-click SDN Controller and select NetSim Console. Now, the client (Net-
SimCLlI.exe) starts and attempts to establish a connection with NetSimCore.exe.

B Ch\Program Files\NetSirm Pro\bin\MetSimCLI.exe

NetSim:>

Figure 3-31: Connection Establishment.

4. Simulate SDN. To do so,

a. In the Run time Interaction under options tab, Interactive Simulation option is set to True.
b. Click the Run button. The Run Simulation pop-up window appears.

c. Simulation time is set to 500 Seconds.
5. Interpret the results.

a. Open packet trace and filter the CONTROL PACKET TYPE/APP NAME to APP1 CBR, and
PACKET ID to 1. Packets reach Wired Node 2 via Wired Node 1 Router 3 ; SDN Controller
i, Router 6.

il 0 CBR Appl_CBR NODE-1 NODE-2 NODE-1 ROUTER-3

1 0 CBR Appl_CBR NODE-1 NODE-2 ROUTER-3 ROUTER-7
1 0 CBR Appl_CBR NODE-1 NODE-2 ROUTER-7 ROUTER-6
1 0 CBR Appl CBR NODE-1 NODE-2 ROUTER-6 NODE-2

Figure 3-32: Packet Animation window

6. Click View Results on the tool bar, Link metrics in the left area and check the Detailed View check
box in the Link Metrics Table pop-up window. You will not see data packet transmissions in links 2,
3, and 4 as shown in below Figure.

Link Metrics
Packets Transmitted Packets Errored Packets Collided

Link ID Bytes Transmitted Payload Transmitt Overhead Transm:
Data Control Data Control Data Control

All 28779

21

28841

nmnm

45077438

11477280

41958340

10513460

3118498

963820

0
0

0

2652
2576
3208

0
0
0

2652
2576
3208

nm
7200

e RV I STV R P

7189

7203
7203

4 o o|= o o|la m~

o o o|lo o ofle o

o o o|lo o ofle o

11428514
11089916

11073292

10466740
10497400
10481340

961774
592516
591952

Figure 3-33: Link Metrics table in Result Window

7. For the same example, configure static routes on Router 3 such that all traffic bound for the 11.0.0.18
subnet will go to a gateway 11.0.0.2, that is, from Router 3 ; Router 4 ; Router 5 ; Router 6.
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To configure the static routes for Router 3:

Simulate the network again by following below steps
b. Now, right-click SDN Controller and click NetSim Console.

c. Now, the client (NetSimCLI.exe) starts and attempts to establish a connection with NetSim-
Core.exe. NetSim CLI console opens.

d. Type the following commands on the NetSim CLI console, in the <DeviceName with Device ID>
route add <destination IP address> MASK <subnet mask> <gateway IP address> <metric>
if <interface #> format.

e. Router_3 route ADD 192.169.0.2 MASK 255.255.255.0 11.0.0.2 METRIC 1 IF 2

f. (Optional) To check the static routes on ROUTER 3, type ROUTER_3 route print. The following
image illustrates step (c) and (d).

® " C:\Program Files\NetSim\Pro_v14_2\bin\NetSimCLl.exe

Interface

Figure 3-34: Route added to network and route printed in command.

8. Interpret the results.

a. Click packet trace from the results dashboard.
b. The packets reach Wired Node 2 via Router 3 ; Router 4 ; Router 5 ; Router 6.

c. Click Link metrics in the left area and check the Detailed View check box in the Link Metrics
Table pop-up window.

You will see data packet transmissions in Links 2, 3, and 4.

The following figure illustrates step (7¢) as shown in below.

Link Metrics

Packets Transmitted Packets Errored Packets Collided
Link ID Bytes Transmitted Payload Transmitt Overhead Transm
Data Control Data Control Data Control

A 200002 161477 264 8 312025546 19091680

1 40590 40321 53 64601534 5417514

39000 31 4 [) 58502788 56871380 1631408

38953 3 4 50432396 56802760 1629636

58362528 56723920 1638608

40384 40326 61 64287508 58871580 5415028

1535 40370 3021720 2242026 1679694

g

1534 40358 3917072 2238180 1678892

Figure 3-35: Link Metrics Table

d. In the simulation results window click on the Open Packet trace option in the left area. Once the
packet trace opens, apply display filters to the CONTROL PACKET TYPE/APP NAME column
to show only OPENFLOW COMMAND and OPENFLOW RESPONSE packets.
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You will see that OpenFlow packets flow between Router 3 to SDN Controller.

9. In Router 3 under application layer use routing protocol as RIP
10. Configure static routes for Router 3 as follows:

a. Simulate SDN (Refer step 4).
b. Right-click SDN Controller and click NetSim Console.

Now, the client (NetSimCLI.exe) starts and tries to establish a connection with NetSimCore.exe. NetSim
CLI console opens.

c. Type the following commands on the NetSim CLI console, in the <DeviceName with Device ID>
route add <destination IP address> MASK <subnet mask> <gateway IP address> <metric>
if <interface #> format.

Router_3 route ADD 192.169.0.2 MASK 255.255.255.0 11.0.0.26 METRIC 1 IF 2

11. Interpret the results.

a. Click View Packets and see the Packet Trace. The packets reach Wired Node 2 via Router 3 ;,
SDN Controller ; Router 6.

PACKET_ID| v |SEGMENT_ID| ~ |PACKET_TYPE ~ |CONTROL_PACKET_TYPE/APP_NAME -¥ |SOURCE_ID| ~ | DESTINATION_ID| ~ [TRANSMITTER_ID| ~ |RECEIVER_ID| ~

i 0 CBR Appl_CBR NODE-1 NODE-2 NODE-1 ROUTER-3
1 0 CBR Appl_CBR NODE-1 NODE-2 ROUTER-3 ROUTER-7
1 0 CBR Appl_CBR NODE-1 NODE-2 ROUTER-7 ROUTER-6
1 0 CBR Appl CBR NODE-1 NODE-2 ROUTER-6 NODE-2

2 0 CBR Appl_CBR NODE-1 NODE-2 NODE-1 ROUTER-3
3 0 CBR Appl CBR NODE-1 NODE-2 NODE-1 ROUTER-3
2 0 CBR Appl_CBR NODE-1 NODE-2 ROUTER-3 ROUTER-7
3 0 CBR Appl_CBR NODE-1 NODE-2 ROUTER-3 ROUTER-7
2 0 CBR Appl_CBR NODE-1 NODE-2 ROUTER-7 ROUTER-6
3 0 CBR Appl_CBR NODE-1 NODE-2 ROUTER-7 ROUTER-6
2 0 CBR Appl_CBR NODE-1 NODE-2 ROUTER-6 NODE-2

3 0 CBR Appl CBR NODE-1 NODE-2 ROUTER-6 NODE-2

4 0 CBR Appl_CBR NODE-1 NODE-2 NODE-1 ROUTER-3
5 0 CBR Appl CBR NODE-1 NODE-2 NODE-1 ROUTER-3

Figure 3-36: Packet flow in trace file after executing the static routes for Router 3

3.4 Configuring Static Routes for a WSN Network by using SDN

In this example static routes are configured in sensors using SDN commands executed in a SDN controller.

The WSN network model in this example consists of the following configuration:

A subnet with 5 wireless sensor, 1 ad-hoc link, 1 wireless sink node, and a unicast sensor application
running on one of the wireless sensors.

One wireless Sensor is configured as the SDN controller.

A unicast application from Wireless Sensor 1 to Wireless Sensor 5.

e Simulation time of 500 seconds.

Packet trace is enabled.

To simulate the example for WSN using SDN:

Open NetSim and Select Examples ; Software Defined Networks ; WSN StaticRoute then click on the
tile in the middle panel to load the example as shown in below screenshot
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[T Metsim Home - 8 X

NetSim Professional
Network Simulation/Emulation Platform ﬁ

Version 14.28 (64 Bit)

New Simulation CtileN  Example Simulations WSN StaticRoute Results.
Your Work Cul-0 Intemnetworks In this example, static routes are configured in sensors using SON commands executed in an
" N controller
Eramples Advanced Routing SON controller
Mabile Adhoc Netwarks e o
Experiments 4 ¥ Software Defined Networks .
Conf SDN ®
omigunng Enabled open flow in all devices
MANET StaticRoute s 2
hanged SON contraller device name & . |
Internetworks StaticRoute Transport protocok UDP Ek -
WSH StaticRoute Static route configuration via CLI & i &
& &
IOT-WSN - e -
Cogritive Radio Networks g
LTE and LTE-A 25

VANETs

Satellite Communication 1
5GNR

TDMA Radlio Networks
Underwater Acoustic Network

License Settings

Exit Ait+F4

Ready to simulate scenzrios to understand the working of the different technology libraries in NetSim. Expand and click on the file name to display simulation examples. Then click on a tile in the middle panel to load the
simulation. Click on the book icon on the left (Exampl panel to (pd.

Support Learn Documentation Contact Us

B Email - sales @tetcos.com
Phone - <91 767 605 4321
Website :

Figure 3-37: List of scenarios for the ezample of WSN StaticRoute

The following network diagram illustrates the network setup considered in this example:

I o - LIRREY -
e t-77 . N
N 1 » -
M - ‘App1_SENSOR_APP ﬁg{
Wireless_Sensor_1 L’ S . Wireless_Sensor_5
4

Wireless_Sensor_2 Wireless_Sensor_4

SinkNode_6

Figure 3-38: Network set up for studying the WSN Static Route

1. The following settings are done in the application layer properties of the devices for configuring SDN:

Table 3-4: Set the properties for all the devices

Device Name Open Flow SDN Controller SDN Controller DeviceName

Wireless Sensor 1 Enable FALSE SDN Controller
Wireless Sensor 2 Enable FALSE SDN Controller
SDN Controller Enable TRUE NA

Wireless Sensor 4 Enable FALSE SDN Controller
Wireless Sensor 5 Enable FALSE SDN Controller
WSN Sink 6 Enable FALSE SDN Controller

2. Configure an application between any two nodes in the scenario by selecting an application from the
Set Traffic tab.

a. Sensor Application from Wireless Sensor 1 to Wireless Sensor 5 with default Generation Rate
(Packet Size: 50Bytes, Inter Arrival Time: 10000004us).
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b. Set Transport Protocol to UDP.

3. Before Simulating the scenario, Right-click SDN Controller and click NetSim Console. Now, the client
(NetSimCLI.exe) waits to establish a connection with NetSimCore.exe.

B C\Program Files\MetSim Prot\bin\MetSimCLIexe

Figure 3-39: Connection Establishment.

a. Enable the packet trace from the Configure Reports tab and click on the Options tab and select
Run time interaction.

File Options Help | Network: Internetworks | Workspace: 30¢t2023
JE Create| Open MATLAB Interface 11l Configure Reports 25 Show/Hide Info

"
3
B Save Static ARP Wired Node = Switch @ a\
oo & = \~
F{] Close &/ J_1 Wireless Node \i‘/ L3 Switch ©

File Run Simulation Node Switch Access Point Router Wired/Wireless Links

Figure 3-40: Runtime Interaction in GUI

b. In the Run time Interaction tab, Set the Interactive Simulation option as True and click on OK.

E Runtime Interaction - O X

NetSim allows users to interact with simulations at runtime via command execution to
view/modify certain device parameters during runtime.

There are two options available for runtime interaction. Interaction can be set to be via a
socket or through a 'input.txt’ file in a predefined format.

This input.txt file accepts all the commands that NetSim's interactive simulation supports.

Interactive Simulation True

File Name Input File Browse

OK Cancel

Figure 3-41: Runtime Interaction Window

c. Click on Run simulation window and simulate it to 500 sec.
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H NetSim - Run Simulation - X

Simulation Time
Enter desired simulation time. Valid range is 0.0001 to 100,000 seconds.
Simulation Time | 500|

Seed Value

Enter seed value between 1 to 99,999,999. The seed values are used to generate random
numbers in simulation

Seed 1 12345678 Seed 2 | 23456789

Run Cancel

Figure 3-42: Run Simulation Window

d. Simulation (NetSimCore.exe) starts to run. NetSimCore.exe displays the following message: wait-
ing for the first client to connect.

B C\Users\JAVDEN\Docurments\NetSim\Workspaces\ gribin_x64\NetSim Core.exe - o X

. Error number 17

Figure 3-43: Waiting for Client to connect.

4. Observe the packet trace after simulation, you will see the direct communication between wireless
sensor 1 and 5.

PACKET_ID| ~ SEGMENT_ID| ~ PACKET_TYPE ~ |CONTROL_PACKET_TYPE/APP_NAME -¥ SOURCE_ID ~ DESTINATION_ID ~ TRANSMITTER_ID - |RECEIVER_ID ~

1 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-5
2 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-5
=i 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-5
4 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-5
5 0 Sensing App1_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-5
6 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-5
7 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-5
8 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-5

Figure 3-44: Direct communication between node 1 and node 5 in packet Animation window

5. For the same example, configure static routes such that the packets will go through Wireless Sensor
1 to Wireless Sensor 5 via SDN Controller. To configure the static routes in SDN Controller for
Wireless Sensor 1 follow the above step 3 as explained above

6. Type the following commands on the NetSim CLI console, in the <DeviceName with Device ID>
route add <destination IP address> MASK <subnet mask> <gateway IP address> <metric> if
<interface #> format.

a. Wireless_Sensor_1 route ADD 192.168.0.6 MASK 255.255.255.0 192.168.0.4 METRIC 1 IF
1

b. SDN_Controller route ADD 192.168.0.6 MASK 255.255.255.0 192.168.0.6 METRIC 1 IF 1
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7. Interpret the results.

Ver 15.0

8. Open Packet trace and filter the CONTROL PACKET TYPE/APP NAME to show only APP1
SENSOR APP, you will see that data packet flow from wireless sensor 1 to wireless sensor 5 through

SDN Controller.

PACKET_ID | ~ |SEGMENT_ID |~ | PACKET_TYPE -

| CONTROL_PACKET_TYPE/APP_NAME

-T|SOURCE_ID | ~ | DESTINATION_ID  ~

| TRANSMITTER_ID | ~ |RECEIVERID |~

) 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-5
10 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-5
11 0 Sensing Appl SENSOR APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-5
12 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
12 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
13 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
8 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
14 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
14 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
15 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
15 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
16 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
16 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
17 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
17 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
18 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
18 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
19 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
19 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5

Figure 3-45: Communication between Sensor 1 5 SDN Controller 5 Sensor 5 in packet trace window

4 Latest FAQs

1. You can refer to the up-to-date FAQs about NetSim’s SDN library at
https://tetcos.freshdesk.com/support /solutions/folders/14000122307.
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